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Informa ii generaleţ

Multe setări ale Editorului de  texte Writer (n.t.:  componenta a  OpenOffice.org,  Writer  s-ar 
putea  traduce  prin  Scriitorul,  pronunţându-se  [raităr];  am  păstrat  denumirea  originală 
neschimbată  deoarece  este  de  fapt  un  nume  propriu)  sunt  controlate  din  meniul  Opţiuni 
("Options"). Acest capitol tratează câteva dintre opţiunile ce privesc instalarea, în mod special 
acelea care nu sunt foarte clare sau sunt greu de găsit atunci când sunteţi la prima utilizare a 
acestui pogram. Opţiunile nu sunt tratate, toate, în detaliu. Pentru detalii complete va trebui să 
apelaţi la Ajutorul integrat în program (meniul "Help").

Copyright şi m rci înregistrateă
Conţinutul acestui document este protejat de Licenţa de Documentaţie Publică, versiunea 1.0 
(numită în continuare Licenţa); aveţi permisiunea de a folosi această documentaţie numai dacă 
sunteţi  de  acord  cu  prevederile  licenţei.  O  copie  a  licenţei este  disponibilă  la  :
http://www.openoffice.org/licenses/PDL.rtf.

Documentaţia  originală  a  fost  scrisă  în  limba  engleză  şi  este  intitulată  “Instalarea  şi
configurarea Editorului de text: Alegerea opţiunilor care se potrivesc stilului dumneavoastră de
lucru“. Autorul primei versiuni este Jean Hollis Weber © 2005. Toate drepturile rezervate. (o 
puteţi contacta la:  jeanweber@openoffice.org. Folosiţi aceată adresă pentru a semnala erorile 
pe care le întâlniţi în documentaţie dacă o citiţi în limba engleză. Pentru limba română vedeţi 
mai jos. Dacă aveţi întrebări despre cum să folosiţi programul, vă puteti abona la o listă de 
discuţii  prin  email,  postând  întrebarile  dumneavoastră: 
http://support.openoffice.org/index.html.)

Traducerea în limba română a documentaţiei a fost realizată de Amăriuţei Gheorghe aka ghrt. 
Toate  drepturile  cuvenite  traducătorului  rezervate.  Pentru  eventualele  inadverdenţe  cu 
originalul în limba engleză sau cu programul îmi puteti trimite mail la ghrt@k.ro, sau pe lista 
de discuţii dev@ro.openoffice.org. Vă rog să specificaţi în subiectul mesajului "Editor de text" 
sau "open office", deoarece primesc foarte mult spam.

Toate mărcile înregistrate aparţin utilizatorilor legitimi.

P rerea dumneavoastră ă
Dacă  doriţi  să  faceţi  comentarii  sau  sugestii  despre  acest  document  vă  rog  să  scrieţi  la 
authors@user-faq.openoffice.org. Pentru  versiunea  în  limba  română,  adresa  este 
dev@ro.openoffice.org.

Mul umiriţ
Mare parte din acest material  a fost pentru prima dată publicat  în  Taming OpenOffice.org 
Writer 1.1, de către Jean Hollis Weber, © 2003.
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Modific ri şi actualiz riă ă

Versiune Data Descrierea modific riiă

1 01/19/05 Prima publicare a ediţiei (în limba engleză)

1 23.02.05 Prima publicare a ediţiei (în limba română)
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Setarea op iunilor care afecteaz  toat  suitaţ ă ă  
de programe Open Office.org

Această secţiune tratează unele dintre setările care afectează toate programele componente  ale 
suitei Open Office.org (numită în continuare OOo) şi care sunt în mod deosebit importante 
pentru utilizarea Writer-ului.  Alte opţiuni cu arie generală sunt tratate în capitolul  intitulat 
"Instalarea OpenOffice.org" din Ghidul Facilităţilor Comune (în limba engleză, capitolul se 
intitulează “Setting Up OpenOffice.org” iar ghidul este denumit "Common Features Guide".)

1) Deschideţi Tools > Options. Lista din partea stângă variază o dată cu componenta OOo 
deschisă.  Imaginile  din acest  capitol  se  referă  numai  la  situaţia  când deschideţi  din 
Writer.

2) Apasaţi semnul "+" din dreptul "OpenOffice.org", în lista din partea stângă din dialogul 
Options. O listă de subsecţiuni este afişată.

Notă Butonul  Back resetează  opţiunile  la  valorile  care  erau  valabile  când  aţi  lansat 
OpenOffice.org. Acest buton face acest lucru în toate căsuţele de dialog din cadrul 
Opţiunilor.

Op iuni privind datele utilizatorului (User Data)ţ
Deoarece  Writer-ul  are  ca facilităţi  semnarea automată a  modificărilor  şi  comentariilor  cu 
numele  sau  iniţialele  introduse  aici,  ar  fi  de  dorit  ca  să  introduceţi  numele  şi  iniţialele 
dumneavoastră. Ca să faceţi aceasta:

1) În dialogul Options, alegeţi OpenOffice.org > User Data. 

1) Completaţi  formularul  de  pe  pagina  OpenOffice.org  –  User  Data  (Imaginea  1) sau 
ştergeţi informaţiile existente dacă sunt incorecte.
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Imaginea 1. Introducerea datelor utilizatorului

Op iuni generaleţ
1) În dialogul Options, alegeţi OpenOffice.org > General. 

2) Pe pagina OpenOffice.org – General (Imaginea  2), opţiunile sunt astfel:

Imaginea  2. Setarea opţiunilor generale pentru OOo
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Ponturi de ajutor (Help Tips)

Când Help Tips sunt active, unul sau două cuvinte vor apărea când ţineţi cursorul deasupra 
unei iconiţe sau a unui câmp din fereastra principală OOo, dar fără să daţi click. Aceasta de 
asemenea afectează afişarea notiţelor (Notes) asociate cu textul: cănd atât Ponturile (Tips), cât 
şi  Ponturile  Extinse  (Extended  Tips)  sunt  oprite,  nu  veţi  vedea  conţinutul  unei  notiţe 
(comentariu, notă de subsol etc.) când ţineţi cursorul deasupra.

Ponturi de ajutor extinse (Help - Extended tips)

Când Ponturile Extinse (Extended tips) sunt active, dacă puneţi cursorul deasupra unei iconiţe, 
unei comenzi sau deasupra unui câmp dintr-un dialog, o scurtă descriere a funcţiei asociate 
respectivei iconiţe, îndeplinite de comanda respectivă ori  a câmpului respectiv apare.

Agentul de ajutor (Help Agent)

Ca să opriţi Agentul de ajutor (Help Agent) (ce îndeplineşte o funcţie similară cu Asistentul 
din Microsoft Office), debifaţi casuţa aferentă. Ca să reveniţi la comportamentul de prima dată 
al Agentului de ajutor, apăsaţi Reset Help Agent.

Înf işarea Ajutorului (Help formatting)ăţ
Contrast ridicat (High contrast) este o setare care ţine de sistemul de operare şi care modifică 
culorile pe ecran astfel încât să fie mai uşor de citit. Ca să afişaţi Ajutorul cu contrast ridicat 
(atenţie! trebuie şi ca sistemul de operare să suporte aceasta), alegeţi unul dintre stilurile cu 
contrast ridicat prezentate în listă.

Dialogurile de Deschidere şi Salvare (Open/Save)

Dacă doriţi  ca dialogurile  folosite  pentru  deschiderea şi  salvarea fişierelor  să  fie  cele  ale 
sistemului de operare, debifaţi căsuţa  Use OpenOffice.org dialogs. Când această căsuţă este 
bifată, vor fi folosite dialogurile de deschidere şi salvare incluse în OpenOffice.org (Pentru 
mai  multe  informaţii  vedeti  şi  capitolul  despre  gestionarea  fişierelor  intitulat  “File 
Management”.)

Statutul documentului (Document status)

Puteţi  să  alegeţi  dacă  imprimarea  documentului  va  avea  semnificaţia  unei  modificări  a 
acestuia. Dacă această opţiune este bifată, atunci când veţi închide documentul după ce l-aţi 
printat se va înregistra în fişier data printării şi veţi fi solicitat să resalvaţi fisierul, chiar dacă 
nu aţi mai făcut altă modificare.

Anul (dou  cifre) - Year (two digits)ă
Specificaţi cum să fie interpretaţi anii din 2 cifre. De exemplu, dacă anul de 2 cifre este setat ca 
1930,  şi  dumneavoastră  introduceţi  în  document  o  dată  calendaristică  cu  anul  de  2  cifre 
începând de la 1/1/30,  anul  este  interpretat  ca 1930.  O dată calendaristică precedentă este 
interpretată ca aparţinând secolului următor, aşa că 1/1/20 este interpretat ca fiind 1/1/2020.
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Op iunile de vizualizare (View)ţ
Alegerea opţiunilor de vizualizare afectează aspectul şi modul de lucru al ferestrei ce conţine 
documentul.

1) În dialogul Opţiuni ("Options"), alegeţi OpenOffice.org > View.

2) Pe pagina OpenOffice.org – View (Imaginea 3), alegeţi opţiunile conform preferinţelor 
dumneavoastră. Câteva dintre opţiuni sunt descrise mai jos.

Imaginea 3. Alegerea opţiunilor de vizualizare pentru componentele OpenOffice.org

Interfa a utilizator - Propor ii (User Interface - Scaling)ţ ţ
Dacă textul folosit în fişierele de ajutor ("Help") şi în meniuri este prea mic sau prea mare, 
puteţi să schimbaţi aceasta specificând un factor de proporţionare. Atenţie, deoarece uneori o 
schimbare poate avea şi efecte neaşteptate, totul depinzând de fonturile instalate pe sistemul 
dumneavoastră. Însă niciodată nu va fi afectată dimensiunea textului din documentul editat.

Interfa a  utilizator  -  Foloseşte  fontul  sistemului  pentru  interfa a  cuţ ţ  
utilizatorul (User Interface - Use system font for user interface)

Dacă în cadrul interfeţei cu utilizatorul preferaţi folosirea fontului sistemului (fontul folosit 
implicit de calculator şi sistemul de operare), în locul fontului folosit de OOo, bifaţi această 
căsuţă.

Meniuri  -  Afişeaz  şi  comenzile  neselectabile  (Menu  -  Show inactiveă  
menu items)

Bifaţi această căsuţă dacă doriţi comenzile neselectabile să fie vizibile (vor fi colorate în gri). 
Dacă debifaţi, comenzile neselectabile nu vor apărea în meniuri.
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Lista  fonturilor  -  Afişeaz  cum  arat  fonturile  (Font  Lists  -  Showă ă  
preview of fonts)

Când bifaţi această căsuţă, lista fonturilor arată ca în Imaginea  4 - stânga, şi anume numele 
fonturilor sunt afişate folosind chiar fontul respectiv. Când această căsuţă este deselectată în 
listă este afişat numele fonturilor cu caracterele folosite de interfaţa cu utilizatorul în mod 
obişnuit (Imaginea  4, dreapta).

În lista fonturilor sunt afişate fonturile instalate în sistem.

Imaginea  4. (Stânga) Lista de fonturi cu vizualizarea acestora; (Dreapta) Doar lista de  
fonturi

Lista fonturilor  - Afişeaz  ultimele  fonturi  folosite (Font Lists - Showă  
font history)

Când bifaţi această căsuţă, ultimele 5 fonturi folosite în documentul curent vor fi afişate la 
începutul listei.

Restaurare - fereastra Writer-ului (Restore – Editing view)

Bifaţi această căsuţă dacă doriţi să deschideţi documentele la poziţia cursorului de dinainte de 
închiderea acestora. Dacă aceasta este debifată documentele sunt deschise întotdeauna la prima 
pagină.

Restaurare - ferestrele deschise (Restore – Open windows)

Bifaţi această căsuţă dacă doriţi  ca toate documentele aflate în editare în momentul în care 
închideţi OpenOffice.org să fie redeschise când îl reporniţi.
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Op iunile de imprimare (Print options)ţ
Alegeţi opţiunile de imprimare care se potrivesc imprimantei dumneavoastră şi modului în care 
tipăriţi de obicei. Puteţi să schimbaţi aceste setări în orice moment, fie tot din acest dialog fie 
din  dialogul  de  imprimare  (File  >  Print),  alegând  din  cadrul  acestuia  butonul Opţiuni 
("Options").

1) În dialogul Opţiuni ("Options"), alegeţi OpenOffice.org > Print.

2) La pagina  OpenOffice.org  – Print (Imaginea  5),  fiţi  atent  la  rubrica  "Avertismente 
privind imprimanta" (Printer warnings) din partea de jos.

3) Aici  alegeţi  dacă  să  fiţi  avertizat  dacă  dimensiunea  paginii  sau  orientarea  hârtiei 
specificate în cadrul formatării documentului nu corespund cu cele disponibile pentru 
imprimanta selectată (şi  care se  presupune că sunt cele  ale  hârtiei  din imprimantă). 
Poate fi de un mare ajutor să lăsaţi bifate aceste avertismente, în mod particular când 
lucraţi cu documente create în ţări ce au alte dimensiuni standard pentru hârtie.

Imaginea 5. Alegerea opţiunilor generale de imprimare care se aplică la toate componentele OOo

Pont Dacă observaţi că ceea ce tipăriţi este poziţionat incorect pe pagină ori trunchiat la 
extremităţi (la început, în partea stângă sau cea dreaptă, la subsolul paginii) sau dacă 
imprimanta refuză să tipărească, cea mai probabilă cauză este nepotrivirea setărilor 
privind pagina.
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Op iunile de aspect (Appearance options)ţ
Compunerea, editarea şi punerea în pagină sunt adeseori mult mai uşor de făcut atunci când 
puteţi vizualiza, la maxim, documentul şi componentele acestuia. Aşa că aveţi posibilitatea de 
a vizualiza elemente ca textul,  tabelele şi perimetrul secţiunilor, ca şi grila ajutătoare (citiţi 
despre  "grid  lines"  în  “Opţiuni  privind  grila  ajutătoare  (Grid  options)”  la  pagina  11). 
Suplimentar,  puteţi  să  alegeţi  culorile  preferate  pentru  elemente  ca indicatori  de  note  (de 
subsol) sau umbriri de câmpuri.

La pagina OpenOffice.org – Appearance (Imaginea 6), puteţi alege ce elemente vor fi vizibile 
şi culorile în care vor fi afişate.

1) În dialogul Opţiuni ("Options"), alegeţi OpenOffice.org > Appearance.

2) Elementele documentului  pot fi  vizualizate sau ascunse bifând sau debifând căsuţele 
alăturate fiecărui element.

3) Pentru a schimba culoarea implicită a elementelor, selectaţi lista cu derulare apăsând pe 
săgeata îndreptată în jos din coloana cu opţiunea privind culoarea de lângă numele 
elementului şi selectaţi o culoare dintre cele care apar.

4) Pentru a păstra culorile alese sub forma unei scheme de culori, scrieţi un nume în căsuţa 
intitulată Schemă ("Scheme") şi selectaţi Salvează (Save).

Imaginea 6. Vizualizarea sau ascunderea textului, a obiectelor şi a marginilor tabelelor
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Alegerea op iunilor privind Writer-ulţ

Setările specificate în secţiunea privind Writer-ul din dialogul  Opţiuni ("Options") al suitei 
OOo determină cum vor arăta documentele dumneavoastră şi cum vor fi interpretate comenzile 
dumneavoastră.

1) Dacă dialogul Opţiuni ("Options") nu este deja deschis,  alegeţi Tools > Options.

2) Selectaţi semnul + de la stânga Writer-ului în secţiunea din partea stângă a dialogului 
Opţiuni ("Options"). O listă de subsecţiuni va apare.

Op iuni generale (General options)ţ
Opţiunile  făcute  în  dialogul  de  Opţiuni  Generale  al  Writer-ului  afectează  actualizarea 
legăturilor şi  a câmpurilor,  unităţile  de măsură pentru rigle  şi  alte măsurători,  dacă vor fi 
adăugate  automat  titluri  diverselor  obiecte  ca  tabele  sau  poze,  spaţierea  paragrafelor,  şi 
aliniamentul tab-urilor.

1) Alegeţi OpenOffice.org Writer > General din dialogul Opţiuni ("Options") (Imaginea
7).

2) Când alegeţi setările pe această pagină nu scăpaţi din vedere următoarele lucruri.

Imaginea 7. Alegerea opţiunilor generale privind Writer-ul

Actualizarea leg turilor la înc rcare (Update links when loading)ă ă
În funcţie de stilul dumneavoastră de lucru, s-ar putea să nu doriţi actualizarea legăturilor la 
încărcarea unui document. De exemplu,  dacă fişierul este legat cu alte fişiere din reţea, nu 
doriţi ca acele legături să fie actualizate şi când nu merge reţeua.
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Actualizarea câmpurilor şi graficelor în mod automat (Update fields and 
charts automatically)

Actualizarea câmpurilor şi graficelor în mod automat în timpul lucrului consumă resurse care 
vă pot fi necesare, iar în acest caz puteţi debifa această funcţie.

Set ri - Aliniamentul tab-urilor (Settings – Tab stops)ă
Aliniamentul tab-urilor este folosit şi pentru spaţierea aplicată de butoanele Măreşte spaţierea 
(Increase Indent) şi Micşorează spaţierea (Decrease Indent) care se găsesc pe bara Obiect 
("Object Bar").

Op iunile privind vizualizarea (View options)ţ
Două pagini de opţiuni privesc setările pentru vizualizarea documentelor în Writer: Vizualizare 
(View), şi Auxiliarele formatării ("Formatting Aids") (descrisă în pagina 10). 

Alegeţi OpenOffice.org Writer > View în dialogul Opţiuni ("Options") (Imaginea 8).

Dacă nu înţelegeti la ce elemente se referă opţiunile de pe această pagină din însăşi denumirea 
lor, puteţi testa cu uşurinţă efectele pe un document gol.

Această pagină este prima pe care o veţi controla dacă, de exemplu, pe ecran nu vor apare 
obiectele grafice, sau dacă în câmpuri sunt afişate formulele în loc de valorile lor.

Imaginea 8. Alegerea opţiunilor de vizualizare pentru Writer
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Op iunile  privind  Auxiliarele  format rii  (Formattingţ ă  
aids)
Afişarea unor simboluri ca sfârşit de paragraf sau taburi vă ajută când scrieţi, editaţi sau când 
aranjaţi în pagină. De exemplu, aţi putea dori să vedeţi dacă au rămas paragrafe fără text sau 
textul include taburi, sau dacă tabelele sau pozele sunt prea mari şi depăşesc marginile paginii.

La  pagina  OpenOffice.org  Writer  –  Formatting  Aids  (Imaginea  9),  selectaţi  căsuţele 
corespunzătoare.

Imaginea 9. Alegerea opţiunilor privind auxiliarele formatării

Notă Cursorul  direct vă lasă să introduceţi text, imagini, tabele, cadre şi alte obiecte în 
orice zonă liberă din document. OOo inserează paragrafe fără text şi tab-uri pentru a 
poziţiona textul sau obiectele. 
Această  facilitate  este  incompatibilă  cu  o  utilizare  riguroasă  a  stilurilor  şi  poate 
conduce la multe ciudăţenii  de formatare, aşa că ar  trebuie evitată în  cazul  unor 
documente profesionale.
Unealta  de  AutoCorectare  ("AutoCorrect")  şterge  automat  paragrafele  fără  text, 
taburile şi spaţiile inserate de către Cursorul direct, astfel încât dacă doriţi să folosiţi 
cursorul direct atunci dezactivaţi AutoCorectarea.
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Op iuni privind grila ajut toare (Grid options)ţ ă
Să specificaţi alinierea la grilă (“snap to grid”) poate fi foarte folositor atunci când încercaţi să 
aliniaţi mai multe obiecte ca poze sau tabele. Dacă însă distanţele între coloanele grilei sunt 
prea mari nu veţi reuşi să obţineţi efectul dorit.

La pagina OpenOffice.org Writer – Grid (Imaginea 10), puteţi alege dacă să activaţi această 
facilitate, şi cât de mare să fie distanţa între coloanele grilei.

Imaginea 10. Alegerea opţiunilor privind grila
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Fonturi implicite (Default fonts)
Fonturile implicite specificate pe pagina OpenOffice.org Writer – Basic Fonts sunt folosite atât 
de documentele din Writer cât şi de documentele de tip HTML (din conponenta WebWriter).

1) Dacă doriţi  să schimbaţi  setările,  o puteţi  face din pagina OpenOffice.org Writer  – 
Basic Fonts (Imaginea 11). Puteţi, desigur, să alegeţi alte fonturi pentru a fi folosite în 
documente,  fie  formatând  direct  în  documentul  respectiv  fie  indirect,  modificând 
stilurile folosite în acel document.

2) Când alegeţi fonturi din această pagină, nu sunteţi limitat la un singur font şi nici chiar 
la cele afişate în lista de fonturi. Puteţi specifica o familie de fonturi, adică un set de 
fonturi  care să includă fonturi  specifice pentru Windows, Macintosh, Linux sau alte 
sisteme de operare. Această posibilitate este importantă în mod special în documentele 
HTML.

3) Dacă documentul este vizualizat pe un sistem care nu are primul font specificat, va fi 
folosit unul dintre celelalte fonturi dacă este vreunul disponibil. Altfel, se va substitui 
un font care este disponibil pe sistem.

4) Introduceţi lista fonturilor, separate de virgule, în câmpuri. Dacă doriţi ca aceste setări 
să fie valabile numai pentru documentul curent, bifaţi căsuţa corespunzătoare. Butonul 
Default reface setările care erau la instalarea suitei OpenOffice.org.

Imaginea 11. Alegerea fonturilor implicite
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Op iunile privind imprimarea (Print options)ţ
La pagina OpenOffice.org Writer – Print (Imaginea 12), puteţi alege ce elemente din cadrul 
documentului  să  fie  tipărite  în  mod obişnuit.  Aceste  opţiuni  vin în  completarea celor  din 
pagina OpenOffice.org – Print (Imaginea 5), care afectează toate componentele OOo.

Câteva observaţii:

• Când lucraţi cu ciorne, şi doriţi să economisiţi cerneala sau tonerul, puteţi să debifaţi 
unele din elementele din secţiunea Conţinut ("Contents").

• Selectarea Tipărire alb-negru ("Print black") face ca textul color (nu însă şi grafica) să 
fie tipărit cu negru la o imprimantă color; la o imprimantă monocromă, această opţiune 
face ca acest text să fie tipărit cu negru obişnuit, nu în nuanţe de gri.

• În afară de Tipărire alb-negru ("Print black"), există şi opţiunea de convertire a culorilor 
în nuanţe de gri ("Convert colors to grayscale") de pe pagina Options – OpenOffice.org 
– Print (Imaginea 5), care tipăreşte toate pozele în nuanţe de gri pe imprimante color (în 
cazul imprimantelor monocrome, oricum pozele în culori sunt tipărite în nuanţe de gri).

• Dacă tipăriţi faţă-verso pe o imprimantă fără duplex, puteţi alege să tipăriţi întâi numai 
paginile  din  stânga  sau  din  dreapta,  şi  apoi  să  puneţi  din  nou  paginile  tipărite  în 
imprimantă şi să imprimaţi celelalte pagini.

• În funcţie de cum ejectează paginile imprimanta dumneavoastră, cu faţa tipărită în sus 
sau în jos, s-ar putea să trebuiască, dacă nu aveţi duplex, să tipăriţi paginile în ordine 
inversă astfel încât să corespundă faţa unei pagini cu verso-ul ei.

Pont Puteţi  să  modificaţi  oricare  dintre  aceste  setări  atunci  când  tipăriţi  un  document. 
Alegeţi  File > Print, apoi alegeţi butonul  Opţiuni (Options) din dialogul Tipărire 
("Print"). Dialogul care apare este similar cu cel din Imaginea 12.
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Imaginea 12. Alegerea opţiunilor de tipărire pentru Writer

Op iuni privind tabelele (Default table options)ţ
Pe pagina OpenOffice.org Writer – Table (Imaginea 13), puteţi specifica parametrii unui tabel 
obişnuit.

Câteva observaţii:

• Dacă majoritatea tabelelor  dumneavoastră vor avea margini  sau cap de  tabel,  bifaţi 
căsuţele respective. Dacă însă folosiţi tabelele pentru a încadra în pagină şi/sau pentru a 
alinia elementele documentului, atunci debifaţi căsuţele de margini şi cap de tabel.

• Recunoaşterea  numerelor  ("Number  recognition")  poate  fi  foarte  folositoare  dacă 
majoritatea  tabelelor  dumneavoastră  conţin  numere;  Writer-ul  va  recunoaşte  datele 
calendaristice sau valuta,  de exemplu,  şi va formata numerele corespunzător. Totuşi, 
dacă doriţi  ca numerele  să rămână simplu  text,  această facilitate  poate deveni  chiar 
iritantă, aşa că ar trebui să o deselectaţi.

• Secţiunea  despre  tastatură  ("Keyboard  handling") specifică  distanţele  cu  care  sunt 
mutate celulele atunci când folosiţi combinaţii de taste pentru a le muta, şi mărimea 
rândurilor şi coloanelor inserate prin comenzi de la tastatură.

• Ceea ce alegeţi în secţiunea privind Comportamentul rândurilor/coloanelor ("Behavior 
of rows/columns") determină efectele pe care schimbările asupra rândurilor şi coloanelor 
le au asupra rândurilor şi coloanelor adiacente şi a întregului tabel. Pentru a înţelege pe 
deplin aceste efecte este bine să testaţi aceste setări.
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Imaginea 13. Alegerea setărilor unui tabel obişnuit
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Op iunile  privind  urm rirea  modific rilor  (Changeţ ă ă  
tracking options)
Dacă  intenţionati  să  folosiţi  facilităţile  pentru  urmărirea  modificărilor,  folosiţi  pagina 
Modificări (OpenOffice.org Writer – Changes) (Imaginea 14) pentru a alege modul în care va 
fi marcat textul inserat şi cel şters, dacă şi cum modificările atributelor vor fi marcate, dacă şi 
cum modificările obiectelor vor fi marcate pe margini.

Imaginea 14. Alegerea opţiunilor pentru urmărirea modificărilor
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Op iuni privind compatibilitatea (Compatibility)ţ
Aveţi nevoie să deschideţi documente Microsoft Word în OOo Writer? Dacă da, veţi dori să 
selectaţi  unele  sau  toate  setările  de  pe  pagina  OpenOffice.org  Writer  –  Compatibility 
(Imaginea 15). Dacă nu sunteţi sigur în privinţa efectului setărilor, lăsaţi-le aşa cum au fost 
setate la instalarea OOo. Pentru informaţii despre aceste setări vă rugăm să consultaţi Ajutorul 
din program (Help).

Imaginea 15. Alegerea opţiunilor privind compatibilitatea

Formatarea  în  func ie  de  set rile  imprimantei  selectate  (Use  printerţ ă  
metrics for document formatting)

Dacă această căsuţă este bifată, imprimanta selectată determină cum este formatat documentul 
când este afişat pe ecran. Sfârşitul de linie şi cel de paragraf de pe ecran vor corespunde cu cel 
aplicat când documentul este tipărit pe imprimanta respectivă.

Această setare poate fi folositoare când mai mulţi oameni lucrează asupra unui document care 
va fi tipărit pe o anumită imprimantă, sau când documentul va fi exportat ca PDF (pentru acest 
lucru se foloseşte o «imprimantă» specială, “Adobe PDF”).

Dacă această căsuţă nu este selectată, va fi folosit atât pentru vizualizare pe ecran cât şi pentru 
formatare pentru imprimare o setare independentă de imprimantă.

Spa iere între paragrafe şi tabele în documentul  curent (Add spacingţ  
between paragraphs and tables - in current document)

În Writer, spaţierea paragrafelor este definită diferit faţă de documentele MS Word. Dacă aţi 
definit  spaţiere  între  două  paragrafe  sau  tabele,  spaţierea  este  de  asemenea  adăugată  în 
documentele MS Word corespunzătoare.

Dacă această căsuţă este bifată, în documentele deschise în Writer este adăugată între paragrafe 
şi tabele spaţiere compatibilă cu spaţierea folosită de MS Word
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Adaug  spa iere  pentru  paragrafe  şi  tabele  la  începutul  paginii  -  înă ţ  
documentul curent (Add paragraph and table spacing at tops of pages - 
in current document)

Puteţi  să optaţi  ca paragrafele  să aibă spaţii  înaintea (deasupra) lor.  Dacă selectaţi  această 
căsuţă, spaţiile de dinaintea unui paragraf vor fi inserate şi dacă paragraful este la începutul 
paginii sau al coloanei, dacă paragraful este situat pe prima pagină a documentului, sau după 
un sfârşit de pagină inserat manual.

Dacă importaţi un document MS Word, spaţiile sunt adăugate automat la conversie.

Adaug  spa iere  pentru  paragrafe  şi  tabele  la  sfârşitul  celulelor  dină ţ  
tabele (Add paragraph and table spacing at bottom of table cells)

Aceasta înseamnă că spaţierea de sfârşit este adăugată unui paragraf, chiar dacă este ultimul 
paragraf într-o celulă de tabel.

Butonul «Foloseşte-le implicit» (Use as Default button)

Apăsaţi  acest  buton pentru ca setările  curente de pe această pagină să devină implicite  în 
OpenOffice.org.
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Op iunile  privind  AutoDescrierile  (AutoCaptionţ  
options)
Doriţi ca OOo să insereze automat descrieri pentru tabele, poze, cadre ("frames") şi obiecte 
OLE inserate într-un document?

Notă Nu întotdeauna o să  doriţi  descrieri  pentru fiecare tabel,  de exemplu atunci când 
folosiţi nu numai tabele cu date dar şi pentru aşezarea obiectelor în pagină. Aşa că 
puteţi întotdeauna adăuga descrieri în mod individual pentru elemente ca tabele, poze 
sau alte obiecte (click dreapta > Caption).

Dacă doriţi descrieri automate pentru unul sau mai multe tipuri de obiecte:

1) Alegeţi OpenOffice.org Writer > AutoCaption în dialogul Opţiuni ("Options").

2) Pe  pagina  OpenOffice.org  Writer  –  AutoCaption  (Imaginea  16),  selectaţi  căsuţa 
alăturată unui tip de obiect care vreţi să fie descris automat (în exemplul de mai jos, 
Imagini - "Graphics").

Imaginea 16. Stabilirea unei noi categorii de obiecte (imaginile) ce vor fi descrise automat

3) Când  elementul  care  vreţi  să  fie  descris  este  selectat,  specificaţi  caracteristicile 
descrierii. Sunt disponibile categoriile  Desen (Drawing), Imagine (Illustration),  Tabel 
(Table), şi  Text. Însă nu sunteţi limitat la aceste categorii. Dacă doriţi să folosiţi altă 
descriere  (de exemplu,  Poză (Figure) )  pentru textul  descrierii,  tastaţi  denumirea în 
câmpul respectiv. În exemplul alăturat, am adăugat la listă categoria “Figure”.

Pentru mai multe informaţii despre numerotarea descrierilor în funcţie de capitol, stiluri pentru 
caractere, stiluri pentru cadre ("frames") sau alte opţiuni ce apar pe această pagină, citiţi  şi 
celelalte capitole din prezentul ghid.
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Set rile  privind  limba  (Choosing  languageă  
settings)

Pentru a face setările de care aveţi nevoie va fi necesar să faceţi câteva operaţiuni:

• Să instalaţi dicţionarele necesare

• Să schimbaţi setări privind localizarea şi limba

• Să alegeti opţiunile privind ortografia

Instalarea dic ionarelorţ
OOo 2.0 instalează câteva dictionare în mod automat, o dată cu instalarea programului. Pentru 
a adăuga alte dicţionare, selectaţi File > Wizards > Install new dictionaries.

Schimbarea set rilor privind localizarea şi limbaă
Puteţi schimba detaliile setărilor de localizare şi limbă pe care OOo le foloseşte pentru toate 
documentele sau numai pentru anumite documente.

1) În dialogul Opţiuni ("Options"), apăsaţi Language Settings > Languages.

2) Pe partea dreaptă a paginii Language Settings – Languages (Imaginea 17), schimbaţi 
Setările  privind  localizarea (Locale  setting),  Valuta  curentă  (Default  currency) şi 
Limbile implicite pentru documente (Default languages for documents) după cum vă 
este  necesar.  În  exemplu,  English  (Australia)  a  fost  aleasă  ca  localizare  şi  dolarul 
australian (AUD) ca valută. Deşi există un dicţionar pentru English (Australia), a fost 
ales ca implicit pentru această limbă dicţionarul English (UK).
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Imaginea 17. Opţiunile privind limba

3) Dacă  doriţi  ca  setarea  privind  limba  (dicţionarul)  să  se  aplice  numai  documentului 
curent, în loc să fie implicit folosit pentru toate documentele noi, bifaţi căsuţa numită 
Numai pentru documentul curent (For the current document only).

4) Dacă  este  necesar,  bifaţi  căsuţele  pentru  a  activa  suportul  privind  limbile 
asiatice(chineză,  japoneză,  coreeană) şi  suportul  pentru  CTL (complex  text  layout  - 
aspect complex al textului) pentru limbi ca hindusă, tailandeză, israeliană şi arabă. După 
ce bifaţi oricare dintre aceste căsuţe, data următoare când deschideţi această pagină veţi 
vedea nişte opţiuni suplimentare privind Setările de limbă (Language Settings), după 
cum se  vede  în  Imaginea  18.  Aceste  opţiuni  suplimentare  (Căutare  în  japoneză  - 
Searching in Japanese, Aspect asiatic - Asian Layout, şi Complex Text Layout - Aspect 
complex al textului) nu sunt discutate aici.

5) Apăsaţi OK pentru a salva modificările şi a închide dialogul.
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Imaginea 18. Setările suplimentare când activaţi suportul suplimentar de limbă

Notă Dacă aveţi nevoie să folosiţi limbi neoccidentale, şi  în mod special dacă doriţi să 
folosiţi mai mult de o limbă neoccidentală în acelaşi document, citiţi tutorialul “OOo 
in a Multi-Lingual Environment” ("OOo în mediu multilingv").

Op iunile privind ortografia (spelling)ţ
Pentru a alege opţiunile privind verificarea ortografiei:

1) În dialogul Opţiuni ("Options"), alegeţi Language Settings > Writing Aids.

2) În secţiunea  Options de pe pagina Language Settings – Writing Aids (Imaginea 19), 
alegeţi setările care vă convin. Câteva observaţii:

• Dacă  nu  doriţi  verificarea  ortografiei  pe  măsură  ce  tastaţi,  debifaţi  Verifică 
ortografia pe măsură ce tastez (Check spelling as you type)  şi bifaţi Nu marca 
erorile (Do not mark errors). (Pentru ultima opţiune căutaţi mai jos în lista de la 
Opţiuni ("Options")

• Dacă  folosiţi  un  dicţionar  particularizat  care  include  cuvinte  scrise  numai  cu 
majuscule şi cuvinte cu numere (de examplu, AS/400), bifaţi Verifică cuvintele cu 
majuscule (Check uppercase words) şi Verifică cuvintele cu numere (Check words 
with numbers).

• Verifică  zonele  speciale  (Check  special  regions) include  headerele  (capetele  de 
pagină), footerele (finalurile de pagină), cadrele ("frames") şi tabelele atunci când 
execută verificarea ortografică.
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• Aici,  puteţi  de  asemenea  verifica  ce  dictionare  definite  de  dumneavoastră  sunt 
active  în  mod  implicit,  şi  să  adăugaţi  ori  să  îndepărtaţi  dicţionare,  apăsând 
butoanele Nou (New) sau Şterge (Delete). 

Imaginea 19. Alegerea limbilor, dicţionarelor şi opţiunilor privind ortografia
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Controlul func iei de AutoCorectareţ

Unii oameni găsesc că unele dintre acţiunile (şi în acelaşi timp, opţiunile) AutoCorectării sunt 
supărătoare, mai ales când schimbă ce aţi tastat deşi nu aţi vrea aceasta. Alţii  găsesc aceste 
acţiuni de un real ajutor; dacă sunteţi de această părere, bifaţi căsuţele care se referă la ce aveti 
nevoie. Şi dacă observaţi că în documentul dumneavoastră apar schimbări neaşteptate, aici este 
primul loc unde trebuie să verificaţi.

Pentru a deschide dialogul AutoCorrect, apăsaţi Unelte(Tools) > AutoCorrect/AutoFormat. 
(Ca acest meniu să apară, trebuie să aveţi un document deschis.)

În Writer, acest dialog are 5 categorii de opţiuni,  după cum se vede în Imaginea 20.

Imaginea 20. Dialogul AutoCorectare în Writer, observându-se cele 5 categorii şi câteva dintre  
opţiunile grupate în categoria Opţiuni (Options)
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